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Introduction

Coastal Explorer is the heart of a PC-based vessel navigation system designed 
specifically to meet the needs of recreational boaters. It is a very easy program to use 
and is focused on helping its user plan a route and then navigate that route.

By using established Windows user interface standards and guidelines, Coastal 
Explorer is able to leverage the knowledge its users gain by using computers for tasks 
other than running their boat. This makes the program much easier to learn (and 
come back to each cruising season) than any other system  available.

Coastal Explorer does not skimp on features in order to achieve simplicity. It has all 
of the important features of other navigation systems. In fact, Coastal Explorer has 
many unique features and some features that are only found in much more expensive 
alternatives.

One very important aspect of any navigation system is its reliability and most PC-
based navigation systems have the reputation of being less than perfect in this regard. 
While many users seem willing to put up with the occasional software crash in order 
to get the convenience of being able to plan their routes with a PC, we find that 
totally unacceptable.

Coastal Explorer is a brand new product, so it doesn’t have much of a reputation yet, 
but during its more than six months of final “beta” testing we repeatedly heard 
reports from users that it was more reliable than the commercial systems that they 
had been using. During our testing, we hunted down and fixed every single reported 
crashing problem. Coastal Explorer also requires Windows 2000 or Windows XP 
which we have found to be significantly more reliable than older versions of 
Windows.

But since no system is perfect, a semi-automatic program update mechanism helps 
users keep up to date with the latest bug fixes and new features.

Standard Navigation Features
Raster, Vector, Photo, and Topographic charts and maps

Seamless Chart “Quilting”

Scrolling and Zooming

Rotation

Automatic Scrolling

Lighting modes: day, dusk, and night

GPS Interface

Autopilot support

Multiple NMEA input ports
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Unlimited routes and waypoints

Range and bearing lines

Boundary areas with alarms

Event recording

Split chart view

Dead reckoning

Virtual instrument display

Maptech Region 1 US Planning Charts

Hundreds of US Electronic Navigation Charts (ENC)

Top Features not found in other Navigation Software
Easy navigation object organization using documents

Integrated gazetteer for searching for places by name

Integrated Guide Books

Multi-Level Undo/Redo

Windows Clipboard support (Cut, Copy, and Paste)

Easily e-mail routes to fellow cruisers

Analog Virtual Instruments

Obstacle Alerts

AIS Receiver Support

Import routes and waypoints made with other programs

Quilting of raster and S-57 ENC charts

Semi-Automatic program updates
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We have found that most recreational boaters cruise seasonally and need to relearn 
parts of more complicated navigation systems each year. As a result, they end up 
using a small number of the available features and often feel their system has a lot 
more than they need.

One of the main things that really sets Coastal Explorer apart from other navigation
systems is the overall user interface which was carefully designed to provide easy 
access to a lot of functionality, and extremely easy access to the most needed 
functions.

Several key techniques were used to accomplish this, including splitting the feature 
set across two “modes,” a much more “Windows-like” user interface, and reduced 
screen “clutter” and window management.

Two Modes
Coastal Explorer uses two different modes of operation to help reduce the amount of 
functionality that must be presented to the user at any given time and to make the 
most important functions easier to access when they are needed. One mode is for 
planning and the other is for cruising. The most appropriate commands for planning 
are easily accessible in planning mode, and the commands most needed while cruising 
are instantly accessible in cruising mode.

Coastal Explorer even switches modes for the user automatically based on movement 
(or lack thereof) of the boat!



Coastal Explorer Reviewer’s Guide 4

User Interface

Windows User Interface Standards
Most navigation programs try to be like a super chart plotter; cramming tons of 
features onto toolbars, but with an attempt to make the program “feel” like a 
dedicated chart plotter. Coastal Explorer uses a different approach; it is a “good 
Windows program” that happens to have a chart plotter-like feature set.

The menu bar in Coastal Explorer will look very familiar to anyone who has used 
Microsoft Office, or any of hundreds of other programs that follow the Windows 
User Interface Guidelines. This is important as most recreational boaters use their 
computers for things other than navigation for most of the year; Coastal Explorer 
exploits the familiarity that users gain during that time to make it easier to come back 
to during cruising season.

Coastal Explorer has familiar commands such as New, Open, Save, and Save As on 
the File menu. Just like in most Windows programs, these commands are used to 
create, open, and save documents. Coastal Explorer’s documents just happen to be 
collection of routes, waypoints, and tracks instead of paragraphs or spreadsheet cells.

The Edit menu has familiar commands such as Undo, Redo, Cut, Copy, Paste, and 
Find. The multi-level undo mechanism in Coastal Explorer allows the user to easily 
correct any mistakes they may have made while editing their routes or other 
navigation objects. The clipboard operations make it easy to transfer routes or 
waypoints between documents and the incredibly useful find feature lets the user find 
any of several million places by entering their name.

Of course Coastal Explorer uses all the standard Windows shortcut keys for accessing 
commands such as Help, New, Open, Save, Print, Cut, Copy, Paste, Undo, Redo, and 
Find.

The toolbars in Coastal Explorer are simpler than most other programs too. Two 
toolbars are provided; one to control the chart display and one to edit navigation 
objects. The icons are clear and simple, and the most common buttons are clearly 
labeled with the name of their function. Less common operations are on the menu 
where they can be found more easily and their functions are made clearer.

Reduced Window Management
Coastal Explorer does not use “floating” toolbars, overlapping chart windows, or 
anything else that might obscure important information or need to be moved around 
on the screen in order to use something else. Everything is kept nice and tidy, side-by-
side on the screen so the user can focus on what they are doing rather than wasting 
time managing their windows.
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Compatibility
Coastal Explorer can use raster and photo charts from Maptech and Softchart 
International, and all S-57 ENC, including those from NOAA, the US Army Corps 
of Engineers, and Nautical Data International (NDI). Topographic maps from the 
US Geological Survey (USGS) and Maptech can also be used.

Quilting
Coastal Explorer uses “chart quilting” to seamlessly display multiple charts at one 
time even when the charts are of different scales. This allows the user to simply pan 
across an area of interest without needing to worry about opening each individual 
chart.

Charts of differing types can be quilted as well. This is especially important in areas 
where complete ENC coverage is not yet available.

With a quilting system, desirable charts may sometimes be obscured by an 
undesirable corner of another chart; Coastal Explorer allows the user to hide or show 
individual charts at any given area. Chart quilting can also be turned off giving the 
user control over exactly which charts they see.

A high-resolution “world shoreline map” is included to provide a background for 
areas not covered by installed charts. While not suitable for navigation, this map is 
detailed enough to discover new islands and coves in places where the user has not yet 
acquired charts.

Orientation
The chart display may be oriented with North up, course up, or heading up. While 
cruising, the chart display can be set to follow the boat’s position with the boat kept 
near the center or near the edge of the display.
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Split Views
The chart display may be split into two or three independent panels. Coastal Explorer 
uses a “tiled” approach for the chart panels which ensures the chart windows never 
overlap thus reducing the amount of “window management” that is needed by the 
user. 

Each chart panel has its own position and scale, orientation, auto-scrolling mode, and 
chart type. When the chart panel is split in two, the second panel becomes a copy of 
the first, but is then zoomed out to ten times the scale. The third panel starts out with 
similar settings, but the chart type is set to “Photo Charts” and the scale is set to 
1:10,000. These defaults make it very easy to perform the most common tasks 
involving split chart views.

Clear Display
Coastal Explorer follows most of the International Hydrographic Office’s S-52 
standard for the display of Electronic Navigation Charts. The primary deviation from 
this standard is in the display of text where the product follows more conventional 
cartographic standards (such as not overlapping text and using italics for features in 
the water). ENC display in Coastal Explorer is immediately familiar to users of other 
ENC systems, but is much more acceptable to people use to paper charts.

As in most other systems, raster charts may be drawn using a “high resolution” 
system that significantly enhances the clarity and readability of the image. Unlike all 
other systems, however, Coastal Explorer’s high-resolution mode is fully automatic. 



Coastal Explorer Reviewer’s Guide 7

Connectivity

Connectivity

Ports
Coastal Explorer can be configured to use any number of COM ports for 
communication with NMEA 0183 devices such as GPS receivers and autopilots. 
Virtual COM ports can also be used over a network. An automatic port scanning 
feature makes it very easy to get started, even when the user does not know which 
port has a GPS on it.

Ports can be configured as “Listeners,” “Talkers,” or “Repeaters” or any combination. 
Listeners receive data from instruments such as GPS receivers and depth sounders. 
Talkers send data generated by Coastal Explorer to instruments such as autopilots. 
Repeaters send the data received by other ports.

Troubleshooting
A Port Troubleshooter is built-in that not only shows the raw NMEA 0183 data being 
received at a port, but also decodes the sentences into meaningful descriptions and 
lists the types of devices that appear to be functioning. In addition, several potential 
problems with the ports are checked and the user is given advice on how to fix them.

Coastal Explorer detects a common problem caused by the limited bandwidth of 
NMEA 0183; when too much data is sent to a “Talker” or “Repeater” port some of the 
data becomes lost or corrupted. Most navigation programs warn users to avoid this 
phenomenon in their documentation. Coastal Explorer not only detects the condition 
and shows an alarm on the screen, but it also adapts to correct the problem before any 
incorrect information is sent to other devices.

Logging
Coastal Explorer can record all of the data received from a port to a log file. The log 
file can have a size limit placed on it to prevent logs from filling a hard drive.

Filters
A simple to use filtering mechanism allows the user to filter out unwanted NMEA 
sentences. This can be done in the Troubleshooter when looking at the sentences
actually being received.

Compatible Equipment Types
Coastal Explorer can display or otherwise use information from many types of 
equipment, including:

• GPS and Loran Receivers

• Heading sensors
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• Depth sounders

• Water speed sensors

• Water temperature sensors

• Wind speed and direction sensors

• Ruder angle sensors

• AIS Receivers

• ARPA/MARPA equipped RADAR units

While most navigation software can display information received from many types 
of devices, Coastal Explorer is unique in its use of analog-style virtual instruments 
which will be described in the Cruising section.

AIS
The Automatic Identification System (AIS) equipment is not yet standard on many
recreational boats due to the high cost, however new “Class B” receivers are becoming 
available for under $1,000 and the prices are expected to continue to drop, making 
these devices much more attractive to many more boaters. 

Coastal Explorer provides complete support for AIS receivers and follows the display 
integration guidelines set forth by the International Maritime Organization. 

Coastal Explorer is also the lowest priced system capable of using AIS, and in fact 
costs less than most AIS “add-ons” for other navigation systems.
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Coastal Explorer provides a very comprehensive set of tools for planning a cruise. 

Navigation Objects
In addition to unlimited waypoints and routes, users can create range/bearing lines, 
boundary circles and areas with alarms, chart annotations and other marks. These, 
along with tracks and event marks, are collectively referred to as “Navigation 
Objects” and are what is stored in the user’s documents.

Each navigation object has properties such as a name, color, etc. These properties can 
be seen and changed with the property panel which is always off to the side of the 
chart and reflects the properties of the selected object.

All navigation objects have some graphical representation that normally appears on 
the charts and can be manipulated in place, but Coastal Explorer also includes a handy 
“Navigation Object Browser” which provides an alternate way of looking things. The 
browser appears below the chart on the screen and displays a list of all of the objects 
of a particular type. Selecting an object on the chart will select it in the list and 
selecting an object in the list will select it on the chart and scroll it into view.

All of the objects have special actions that can be performed on them by clicking the 
right-mouse button to access their menu. These menus can be used on the chart 
display, or in the browser.

Coastal Explorer lets the user select more than one object at a time, either by 
Shift+Clicking on objects, or by dragging a selection rectangle around a group. This 
makes it possible to delete or copy a number of objects in one action.

Object Highlighting
Sometimes when planning a route, the marks and leg-lines can get “lost” in the lines 
of the chart. This is especially true with raster charts which tend to contain a lot of 
information all of the time. Coastal Explorer has a feature to help solve this problem 
by washing out the image of the chart, just a bit, so that the route being construction 
stands out much better. This is the “Highlight Objects” command on the toolbar.
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Obstacle Alerts
Creating a route with most navigation systems typically involves laying down a 
“rough draft” with the chart at a small-scale and then zooming in and tweaking each 
leg-line to make sure it doesn’t intersect anything. This can be a tedious and time 
consuming process.

Coastal Explorer uses information that is available in the vector charts to detect and 
point out obstacles and other potential dangers along a route being created. While a 
leg-line is being dragged out on the screen, it is drawn in black if no obstacles are 
found or red if something is there. During route creation, the property panel to the 
right of the chart changes to a list of obstacles that have been found along the route. 
The same feature is activated when an existing route is modified by dragging a 
waypoint and will work as long as a vector chart for the area is installed even if the 
user chooses to view raster charts.

The obstacle detection in Coastal Explorer makes it much more likely that the “rough 
draft” route created at a small scale will be very close to the final route. Plus, if the 
user does go back in to tweak things, they will be warned if moving a waypoint causes 
problems with either of the leg-lines connected to it.

Route Details Panel
A “Route Details” panel is available for calculating total length of a route, estimated 
times of arrival, turn angles and various other details of a route. These details can be 
printed along with an overview chart of the area covered by the route.

Waypoint Styles
Most navigation programs use a “connect the dots” approach to routes. Coastal 
Explorer can work this way too, but provides some additional options via “waypoint 
styles.” 

The “Arrival Circle” waypoint style is similar to most other systems where each leg-
line of a route simply connects two waypoints. Waypoints with this style are shown 
as circles indicating the “arrival” area for the waypoint and a line indicating what 
must be crossed in order to “pass” a waypoint.

The “Wheel Over Line” waypoint style uses estimated turning radius information to 
show where the captain should start a turn in order to end up on the next leg-line 
rather than going past it.
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The “Predicted Log Race” waypoint style uses the turning radius information to show 
the estimated path the boat will take if it the captain starts the turn exactly at the 
waypoint. In addition to showing the curved path, this waypoint style will calculate 
the extra distance traveled during the turns and the adjusted headings to each 
waypoint. While this is all estimated information, it can make planning a predicted 
log race much easier than doing the calculations and adjustments by hand!

Transferring Objects between Computers
Since many boaters will plan a cruise at home on one computer and then need to get 
that plan to the computer on their boat, Coastal Explorer makes it easy to transfer 
things from one place to another. Since documents are used to store navigation objects 
(rather than a hidden database), a user can simply copy the document file using the 
Windows Explorer. A shortcut to copy the current document to a floppy disk or other 
removable storage unit is provided within Coastal Explorer as well (the “Send To” 
command on the File menu).

The Send To command can also be used to send a copy of the current document as an 
email attachment in case several Coastal Explorer users will be cruising together. 
When a navigation object document is received in email, the recipient need only open 
the attachment with their email program and Coastal Explorer will start up and load 
the document!
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Coastal Explorer can also read files that were exported from other navigation 
programs including Nobeltec, The Cap’n, and Maptech and it can write files that can 
be imported by Nobeltec.

Guide Books
It is sometimes necessary to check information other than charts when planning a 
cruise; most boaters use some form of guide book to get local knowledge, and some 
navigation systems provide the US Coast Pilot™ books in the form of Windows Help 
files. Coastal Explorer takes this sort of guide book feature to a new level by 
integrating the US Coast Pilot™ books with the charts. Rather than requiring a search 
though help files, Coastal Explorer lets users point to a location on the chart to call up 
information for that area.

Find
The find feature in Coastal Explorer is a welcome addition to any boater who has 
been told “you need to go to such-and-such place” and then tried to find it on a chart. 
While some other programs have the ability to find places by name, none of them do 
it as simply as Coastal Explorer (and with most programs, even the ability to install 
the necessary data is so hidden that most users don’t even know the feature exists). 
We have found that the need to find places by name is so common, we placed a box 
on the toolbar where the user can type in the name of a place and jump right to it.

The gazetteer in Coastal Explorer lists millions of places in the US, Canada, and 
Mexico, and add-on gazetteers including millions of places in the rest of the world can 
be downloaded from the Rose Point Navigation Systems website.
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Alternate User Interface
In cruising mode, Coastal Explorer takes over the entire screen and hides its own 
menu bar and toolbars to maximize the amount of chart seen by the user. A function 
bar consisting of big, fat, easy to press buttons provides access to the commands most 
likely to be needed while underway. These buttons are easy to use with a touch screen 
or just about any pointing device even when the boat is moving and the captain has 
better things to do than try to aim a mouse at a small target.

Boat Display
The boat is displayed as an icon on the chart at its current location and with the 
correct orientation. One or more range circles can be shown around the boat at set 
distances. 

A track line can optionally show the actual track across the chart the boat has taken,  a 
“predictor” shows where the boat will be in a certain amount of time at its current 
course and speed, and a line is drawn between the boat and the active waypoint.
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An optional compass also follows the boat and has lines radiating across the chart 
every thirty degrees. These lines are handy for correlating visual sightings with 
objects on the chart.

Virtual Instruments
Coastal Explorer also displays one or more virtual instruments which may be 
customized by the user depending on the equipment they have connected to their PC. 
Among the available options are an analog-style compass with a waypoint direction
indicator, a depth strip-chart, analog-style relative and true wind indicators, and a 
graphical rudder angle indicator.

The “Data Console” is a single optional panel that can be configured to display 
information from more than one instrument, including digital and analog displays for 
many items, and even small graphs for depth and water temperature.

Obstacle Warnings
The same technology that drives the obstacle detection during route creation is used 
to warn of obstacles ahead of the boat while underway. Since the captain should be 
looking out the window and not at the computer screen, though, the warnings come 
in the form of a synthesized voice rather than just a line on the screen.

Moving Map
Coastal Explorer can automatically scroll the chart as the boat moves and either keep 
the boat icon near the center of the screen, or near the edge (so the maximum amount 
of chart ahead of the boat is visible). 

Another auto-scroll option, which is unique to Coastal Explorer, is the ability to 
“Follow the Leg-Line.” This handy feature kicks in each time a new waypoint is 
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activated and will scroll and scale the chart so that the boat’s location and the active 
waypoint are near the edges of the screen. This means that the chart will 
automatically zoom in while the boat is navigating in a tighter area where waypoints 
are closer together (such as through a channel) and zoom out in more open areas 
where waypoints tend to be farther apart.

Dead Reckoning
Coastal Explorer can use dead reckoning to predict the boats location based on speed 
and heading over time. This feature can be important in the case of a GPS failure, and 
can also be used to simulate a cruise in order to gain familiarity with the program.

Dusk and Night Modes
Coastal Explorer can be switched to dusk and night modes to help maintain night 
vision by dimming the screen or switching to a black and red display mode.
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The Future of Coastal Explorer

We are not finished with Coastal Explorer! Rose Point Navigation Systems is 
dedicated to the support of its customers and will continue to make sure Coastal 
Explorer is the most reliable and easiest to use vessel navigation software available.

Unlike many software companies these days, Rose Point Navigation Systems does
not intend to make money selling product support. We feel that doing so is counter-
productive in that there is little incentive to improve the usability of the product 
when that would mean a reduction in revenues! Instead, our product support and 
product development teams work very closely together to make sure that any 
problems that users are running into get fixed in the product and not just in the 
“knowledge base.”

We are also continuing to improve the functionality of the system by adding some 
features that did not make it into the first version. Many of these features will be 
given to registered users free of charge while others will be sold as separate “add-on” 
products. By supplying some major new features in the form of separate add-ons, we 
hope to reduce the cost and complexity for those users who do not need them.

We are particularly excited about a new service about to be launched. It’s the “Coastal 
Explorer User’s Network” and is a web site at http://coastalexplorer.net. This 
website will be a place for Coastal Explorer users to read and share useful tips and 
tricks, get information about getting particular pieces of equipment to work, and even 
host their own cruise log web page on “The Ship’s Blog.” The website is live now, but 
not yet fully operational. We’ll make an announcement when it’s ready.

After reviewing our product, we hope you agree with us when we say “Navigation 
Software Just Got a Lot Better!”


